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Chapter 1

Getting started
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Waking up the system

To make a call you need to wake up the system from standby. However, if someone 
calls you, the system will wake up by itself.
•	 To wake up the system just pick up the TRC5 remote control or press any key. You 

may have to point the remote control towards the system to make sure it discovers 
you.

•	 The system will now display the wallpaper.
•	 The dial-in address or dial-in number of your system is displayed in the upper left 

corner. If you have questions about the dial-in address or number, contact your 
system administrator.

•	 The screen will also indicate if there are any calls you have missed.

.

The dial-in address or dial-in number of your system 
is displayed in the upper left corner. Date and time of day.

After wake-up, the screen will typically look like this:

Softkeys (described on the following pages).

Sept

20

norah.dollhouse@somecompany.com

If the system fails to respond to the remote control or to incoming calls, make sure that:
•	 The system is connected to line voltage.
•	 The remote control has working batteries.
•	 The internal cables, such as the monitor cable and/or the camera cables are properly 

connected, see the installation sheet for details, if needed.
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Microphone On/Off.

Adjust loudspeaker volume.

Use the Arrow keys to navigate in the 
menus and the center  key to confirm 
your choice or selection. 
When no menu is open, Arrow keys 
can be used to move the camera.

Use this key to display the Main 
menu on the screen.

Use this key to display the Phone 
book (your contacts) on the screen.

Place a call.

Use this key to remove characters in 
a text field.

Switch to show PC screen on the 
system. Press again to go back to the 
main camera.

Open the Presentation menu to 
select other sources. Press and hold

Press and hold

Press and hold

These keys correspond to the five context 
sensitive softkeys along the bottom  

of the screen.

Use this key to change the layout on 
the screen.

Use this key to end an ongoing call.
Outside a call, press and hold to enter 
the standby mode.

Use the keypad to enter letters and 
numbers, as with a mobile phone.
Press a key repeatedly to access the 
characters displayed on each key.

Press and hold the # key to switch 
between touch tone mode (press 
and hold), lower case characters and 
numbers.

Use this key to enter touch tone mode 
(DTMF) in a call. Press the  key when 
done.
When entering text this key is used to 
toggle between upper and lower case 
letters.
Press and hold to change between 
characters and numerics.

Waking up the system
Grab the remote control and make sure your hand 
touches the rubber line sensors located on both sides of 
the remote control, or just touch any key on the remote 
control.Zoom the camera.

D14844.01 May 2011

Overview of the 
remote control



www.cisco.com6

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20 User guide

D14852.02 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, November 2011.  
All contents are copyright © 2010–2011 Cisco Systems, Inc. All rights reserved.

Navigating in the menus

Use the remote control to operate your video system. A few basic navigation 
principles are all you need to know to get started.
•	 Press the Home key ( ) to show the Home menu or wake up the system by lifting 

the remote control.
•	 The Arrow keys in the center of the upper part of the remote control are used to 

navigate in the menus. 
•	 When the system shows the Home menu only (see the Fig. below), pressing Home 

key ( ) will hide the menu. To bring it back, press the Home key ( ) again.

•	 In an input field, pressing C will delete characters/numbers to the left of the cursor 
position.

•	 When the system shows the Home menu only (see the Fig. below), pressing Home 
key ( ) will hide the menu. To bring it back, press the Home key ( ) again.

•	 In an input field, pressing C will delete characters/numbers to the left of the cursor 
position.

Press the  key to display the Home menu on the screen.

The element currently 
selected is indicated by an 
orange rectangle. 
Use the  and  Arrow 
keys to navigate up and 
down in a menu.

The little triangle 
indicates that 
a submenu is 

available.

Example showing a submenu displayed by pressing the right arrow key.

Use the  Arrow key to collapse the 
menu expansion (to go back one 

level).

Use the Home key ( ) to exit all menus 
and return to showing the Home menu 
only.

Context sensitive softbuttons 
corresponding to the function 
keys of the  
remote control.

Softbuttons not used in a 
given context are shown 
ghosted (gray).

Call

Meetings

Presentation

Camera control

Settings

HOME

Call

Presentation

Camera control

Settings

Call

Phone book

Recent calls

Add another participant

CALL

Enter contact...
123

Call

Meetings

Presentation

Camera control

Settings

HOME

Call

Presentation

Camera control

Settings

Call

Phone book

Recent calls

Add another participant

CALL

alice.wonderland@company.co.nla 
Received 20.09.11 16.29

hedda.gabler@somecompany.org 
Placed 20.09.11 15.10

dorian.grey@myself.net 
Missed 20.09.11 14.55

frodo,b.aggins@myshire.org 
Received 20.09.11 12.20

floria.tosca@somecompany.org 
Placed 20.09.11 08.17

RECENT CALLS

Sept

20

View Recent calls Delete call history Call rate 768 kbps

Call

Meetings

Presentation

Camera control

Settings

HOME

Call

Meetings

Presentation

Camera control

Settings

HOME
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Virtual keyboard detailsInvoking the virtual keyboard

Entering text in text fields

Some menu fields expect text information to be entered. This is used to enter the 
name, number or address of the person you want to call as well as for such things as 
to search in the phone book and to maintain your list of contacts (the My contacts).

Text entry essentials
•	 If you press a number key when you are not in a call, the Call menu will be shown.
•	 The system will automatically switch �to text mode (abc) inside entry fields expecting 

text entries. The easiest and most convenient way of entering letters is by invoking 
the on-screen virtual keyboard. Do as shown below to invoke the keyboard.

•	 You may also use the keypad in the same manner as when composing text 
messages on a mobile phone, but the virtual keypad is by far more convenient and 
it is also faster to use.

•	 Press Function key number two from the left to invoke the virtual keyboard if it 
does not appear by itself.

•	 Use the  Arrow key to move the cursor inside the keyboard. 
•	 Use all four Arrow keys to move about the keyboard.
•	 When the required key is reached, press  to have the letter or digit inserted in the 

entry field.
•	 If you navigate to the alpha/numeric selection field, pressing  will take you to 

numeric from alpha and vice versa. Navigate and select inside here to the extent 
needed. The same principle applies if you need to enter special characters.

•	 Once entered, press the Function key to hide the keyboard. This will put your entry 
into effect.

Press as shown to 
produce the virtual 
keyboard.
Press again to hide 
the virtual keyboard.

Navigate to here 
and click  to switch 
between letters and 

digits.

Context sensitive 
fields will appear 

here. In this example 
you may start a call 

from here.

Navigate to here  
and click  to 
access special 
characters.

abc / 123 Turn keyboard on

Call

Meetings

Presentation

Camera control

Settings

HOME

Call

Presentation

Camera control

Settings

Call

Phone book

Recent calls

Add another participant

CALL

Enter contact...
123

abc / 123 Turn keyboard on

Call

Meetings

Presentation

Camera control

Settings

HOME

Call

Presentation

Camera control

Settings

Call

Phone book

Recent calls

Add another participant

CALL

Enter contact...
123
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Tip: Adding a wallpaper to your screen

Change remote layout (the outgoing video) when hosting  
MultiSite Conference...

Screen layout

The layout of the screen can be changed as shown to the right.
To show the display options screen, press the Layout  ( ) key. Alternatively, you 
may get to it through Settings > Layout. 
•	 Use the Arrow keys to move between the alternatives and use  to select the 

alternative you want to use.
•	 You may—or may not—include selfview (to show the outgoing video signal from 

your own system). This will show you what others will see from your system.

In the Settings 
submenu 
navigate down 
to Wallpaper. 
Press   again. 

In the Home menu, navigate down to 
Settings and press the  key.

Select between the options 
available and press the 
 key to leave the menu 

putting your choice into 
effect. See also  page 

20 for more on this.

However, if you 
already have 
activated the 

selfview, the menu 
will give you these 
options when you 

enter the menu 
again.

However, if you 
already have 
activated the 

selfview, you may 
select where the 

selfview should 
appear in the image 
when you enter the 

menu again.

Layout control outside a 
call is limited to the choice 
between showing selfview 
and showing a wallpaper...

Layout control when in a 
call provides the choice 
of showing selfview or full 
screen participant...

Call

Meetings

Presentation

Camera control

Settings

HOME

Layout

Main source: Camera

Call settings

Language: English

Date and time

Sounds and alerts

Wallpaper: Growing

System information

Administrator settings

Restart

SETTINGS

Call

Meetings

Presentation

Camera control

Settings

HOME

Layout

Main source: Camera

Call settings

Language: English

Date and time

Sounds and alerts

Wallpaper: Growing

System information

Advanced

Restart

SETTINGS

LAYOUT CONTROL

Show selfview

Wallpaper

Call

Meetings

Presentation

Camera control

Settings

HOME

Layout

Main source: Camera

Call settings

Language: English

Date and time

Sounds and alerts

Wallpaper: Growing

System information

Advanced

Restart

SETTINGS

LAYOUT CONTROL

Hide selfview

Wallpaper with selfview

Full screen selfview

Call

Meetings

Presentation

Camera control

Settings

HOME

Layout

Main source: Camera

Call settings

Language: English

Date and time

Sounds and alerts

Wallpaper: Growing

System information

Advanced

Restart

SETTINGS

LAYOUT CONTROL

Show selfview

Full screen participant

Call

Meetings

Presentation

Camera control

Settings

HOME

Layout

Main source: Camera

Call settings

Language: English

Date and time

Sounds and alerts

Wallpaper: Growing

System information

Advanced

Restart

SETTINGS

LAYOUT CONTROL

Show selfview

Speaker participant

Full screen participant

Remote layout

LAYOUT CONTROL

Show selfview

Speaker participant

Full screen participant

Pressing Layout  
( ) will produce a 
softkey letting you 
choose the layout 
of the outgoing 
video. Select among 
all defined layouts 
available. Note that 
you have no influence 
on the actual layout on 
the remote system.

Layout control

Call

Meetings

Presentation

Camera control

Settings

HOME

Call

Meetings

Presentation

Camera control

Settings

HOME

Layout

Main source: Camera

Call settings

Language: English

Date and time

Sounds and alerts

Wallpaper: Growing

System information

Administrator settings

Restart

SETTINGS

None

Growing

Summersky

Custom
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Camera presets

You may create predefined settings of where the camera points and the zoom. This 
is referred to as camera presets. See the next page for more.

Using the presets

Camera presets must have been defined before you 
do this.

Press the  key on the remote control to display the 
Home menu and select Camera control. Use the  and 

 Arrow keys to navigate in the menu. Use  to select 
a preset. The camera will now move accordingly. Note 
that this feature may be used any time.

Camera presets must have been defined 
before you do this.

Press the  key on the remote control to 
display the Home menu and select Camera 
control. Use the 0~9 keys to select a preset. 
The camera will now move accordingly. Note 
that this feature may be used any time.

Pos. 1

Pos. 2

Pos. 3

Edit camera preset

CAMERA PRESETS

Where to find camera presets

Call

Meetings

Presentation

Camera control

Settings

HOME

Sept

20

Camera presets Camera settings Main source Exit
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Adding a new camera preset (I)

In the Camera presets menu 
navigate to Edit camera preset 
and press the  key.
Any presets already existing are 
listed here.

Navigate to the undefined 
preset you would like to define.
When you have located it, 
press the  key. 

Pos. 2

Pos. 2

Pos. 3

Edit camera preset

CAMERA PRESETS

Default

Zoom out

Whiteboard

Edit camera preset

CAMERA PRESETS

SET CAMERA PRESETS

Default

Zoom out

Whiteboard

Not defined

Not defined

Not defined

Not defined

Not defined

Not defined

Outside a call, press the 
Layout key and select Show 
selfview followed by the  
key, if needed. You will now 
see the outgoing video from 
your system.

Adjust pan, tilt and 
zoom, as required.

LAYOUT CONTROL

Show selfview

Wallpaper

Press the  key to display 
the Main menu and 
navigate to  
Camera control. 
Press the  key. 

This will display the softkeys along the bottom of the 
screen, as shown.

Display the Camera presets 
menu by pressing the Function 
key corresponding to the 
Camera presets softkey on 
the remote control to open the 
menu.

Call

Meetings

Presentation

Camera control

Settings

HOME

Camera presets Camera settings Main source Exit
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Adding a new camera preset (II)

Default

Zoom out

Whiteboard

Edit camera preset

CAMERA PRESETS

EDIT CAMERA PRESETS

Default

Zoom out

Whiteboard

Not defined

Not defined

Not defined

Not defined

Not defined

Not defined

Name

Save new preset

Cancel

abc

4:NEW PRESET

Name

Save new preset

Cancel

abc

4:NEW PRESET

The virtual 
keyboard will now 
automatically be 
invoked by the 
system.

Use the  Arrow key 
as shown to move 
the cursor up into the 
virtual keyboard (the 
cursor is indicated by 
an orange square).

Name

Save new preset

Cancel

abc

4:NEW PRESET

charl

abc

Name

Save new preset

Cancel

4:NEW PRESET

charlie watts

Give the new preset a 
descriptive name. 
Use the Arrow keys to 
move about the keyboard 
and the  key to select a 
character. 
Access special characters 
and numerics by means of 
the corresponding keys. 

Press the  Arrow 
key a sufficient number 
of times to move the 
cursor down to Save new 
preset, as shown.

Press the  key to put your 
changes into effect. This 
will be confirmed by the 
system. 

SET CAMERA PRESETS

Default

Zoom out

Whiteboard

charlie watts

Not defined

Not defined

Not defined

Not defined

Not defined

To leave the menu, press 
the  key.
Alternatively, you may 
define another preset or 
redefine existing (see the 
following page for more).
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Editing an existing camera preset (I)

In the Camera presets menu 
navigate to Edit camera preset 
and press the  key.
Any presets already existing are 
listed here.

Navigate to the existing preset 
that you would like to redefine.
When you have located it, 
press the  key. 

Pos. 2

Pos. 2

Pos. 3

Edit camera preset

CAMERA PRESETS

Default

Zoom out

Whiteboard

Edit camera preset

CAMERA PRESETS

SET CAMERA PRESETS

Default

Zoom out

Whiteboard

Not defined

Not defined

Not defined

Not defined

Not defined

Not defined

Outside a call, press the 
Layout key and select Show 
selfview followed by the  
key, if needed. You will now 
see the outgoing video from 
your system.

Adjust pan, tilt and 
zoom, as required.

LAYOUT CONTROL

Show selfview

Wallpaper

Press the  key to display 
the Main menu and 
navigate to  
Camera control. 
Press the  key. 

This will display the softkeys along the bottom of the 
screen, as shown.

Display the Camera presets 
menu by pressing the Function 
key corresponding to the 
Camera presets softkey on 
the remote control to open the 
menu.

Camera presets Camera settings Main source Exit

Call

Meetings

Presentation

Camera control

Settings

HOME
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Editing an existing camera preset (II)

Default

Zoom out

Whiteboard

Edit camera preset

CAMERA PRESETS

EDIT CAMERA PRESETS

Default

Zoom out

Whiteboard

Not defined

Not defined

Not defined

Not defined

Not defined

Not defined

Press the  key to put your 
changes into effect. This 
will be confirmed by the 
system. 

Update to current camera position

Delete preset

Cancel

3:WHITEBOARD

Navigate to: 
•	 Update to current camera position to 

redefine the preset 
•	 Delete preset to remove it from the list 
•	 Cancel to prepare to leave the menu 

undoing any updates.
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Adjusting the whitebalance of the cameraAdjusting the exposure of the camera

Camera settings

Camera settings let you adjust the exposure and whitebalance.
Do as follows:

1.	Press the  key on the remote control to display the Layout menu. Select Selfview 
to be shown as required.

2.	Press the  key to display the Home menu and select Camera control.

3.	This will cause softbuttons to appear. Press the Function key corresponding to 
Camera settings (Function key number 2 from the left).

4.	Follow the procedures outlined below.

If you change the Brightness 
mode to Manual, the 
Brightness level becomes 
possible for you to set. Since 
Auto has been chosen here, 
the actual level is shown 
ghosted.

Backlight compensates for any backlight shining on 
the camera from behind you. Such light conditions 
will tend to make you appear darker than needed.

Since the whitebalance has been set to Manual in this case, you will have access to 
setting the whitebalance in the usual manner. Use Automatic if that is more convenient.

CAMERA SETTINGS

Exposure

Whitebalance

CAMERA SETTINGS

Exposure

Whitebalance

Brightness mode: Auto

Brightness level: 1

Backlight: Off

EXPOSURE

Whitebalance mode: Manual

Whitebalance level: 1

WHITEBALANCE
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The call settings optionsMain source settings

Main source

You may choose what to use as the main input source. This will typically be the 
camera, a secondary camera (if applicable), the PC input or other sources such as a 
DVD player. 
Do as follows:
1.	In the menu select Settings > Main source and expand the submenu.
2.	Use the Arrow keys to move between the alternatives and use  to select the 

alternative you want to use.
3.	Collapse the menu using the  Arrow key.

Call settings—an overview

Use the Call settings menu to set the default bit rate and how the system shall answer 
incoming calls. Answering can be set to automatic or to manual. More on this can be 
found on the next page.
Do as follows:
1.	In the menu select Settings > Call settings and expand the submenu.
2.	Use the Arrow keys to move between the alternatives and use  to select the 

alternative you want to use.
3.	Collapse the menu using the  Arrow key.

This example has been 
taken from a Codec C20 
equipped Profile. Larger 
systems may have more 
options.
More on Profile systems 
and their codecs can be 
found on  page 30. 
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CALL SETTINGS

Auto answer mode: On

Auto answer delay: 5 sec

Auto answer mute: Off

Do not disturb mode: Off

Default callrate: 4000 kbps
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The default call rate options

Call settings—auto answer options

You may set up your system to answer automatically whenever someone calls you. 
If you choose to do so, you may also specify how long time it shall take before your 
system connects you. 
For privacy reasons you may want your microphone to be muted (turned off) when the 
system answers automatically. Alternatively, you may set the system to Do not disturb.

Call settings—default call rate

The Call settings menu lets you set the default call rate expressed as default number 
of kilobits per second. 
You may want to consult your system administrator to discuss the best setting in your 
environment. 

Use the  and   Arrow keys 
to alter how long time it shall 
take before your system 
connects you. Interval is 0–50 
seconds.

For privacy you may set the 
microphone to be muted upon 
autoanswer. You will then have to 
activate the microphone yourself 
(press ).

To further enhance your privacy 
you may set the system to Do 
not disturb. Your system will then 
not respond to incoming calls. As 
soon as you disable the Do not 
disturb any call attempts made 
while the feature was enabled 
will be listed as missed calls.

Set to On to have your 
system answer incoming 
calls automatically and Off to 
answer them manually.

CALL SETTINGS

Auto answer mode: On

Auto answer delay: 5 sec

Auto answer mute: Off

Do not disturb mode: Off

Default callrate: 4000 kbps

On

Off

CALL SETTINGS

Auto answer mode: On

Auto answer delay: 5 sec

Auto answer mute: Off

Do not disturb mode: Off

Default callrate: 4000 kbps

On

Off

CALL SETTINGS

Auto answer mode: On

Auto answer delay: 5 sec

Auto answer mute: Off

Do not disturb mode: Off

Default callrate: 4000 kbps

On

Off

CALL SETTINGS

Auto answer mode: On

Auto answer delay: 5 sec

Auto answer mute: Off

Do not disturb mode: Off

Default callrate: 4000 kbps

Call

Meetings

Presentation

Camera control

Settings

HOME

Layout

Main source: Camera

Call settings

Language: English

Date and time

Sounds and alerts

Wallpaper: Growing

System information

Advanced

Restart

SETTINGS
128

256

384

512

768

1152

1472

1920

2560

3072

4000

CALL SETTINGS

Auto answer mode: On

Auto answer delay: 5 sec

Auto answer mute: Off

Do not disturb mode: Off

Default callrate: 4000 kbps

Scroll with the  and  Arrow 
keys to access settings not 
shown.

The options in detail

Options are 128, 256, 384, 512, 768 (initial default), 1152, 1472, 1920, 
2560, 3072, 4000 and 6000 bits (not shown in Fig.) per second.
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Date and time settings overview

Language settings options

Language settings

This will allow you to specify the language used in the menus and settings shown. The 
following languages are supported: English, Norwegian, Swedish, German, French, 
Italian, Japanese, Russian, Spanish, Korean, Finnish, Chinese (Simplified), Turkish, 
Polish, Hungarian, Czech.
Do as follows:
1.	Start from the Home menu and navigate down to Settings and press the  key. 
2.	Then navigate to Language and press the  key again. Use the  and  Arrow keys 

to select.
3.	Press the  key to exit the menu putting changes into effect or the  

 Arrow key to leave the menu going one step back.

About the setting of date and time

You may have the system pick date and time for you or you may specify date and time 
zone settings along with date and time format and the date and time of day itself. 
Do as follows:
1.	Start from the Home menu and navigate down to Settings and press the  key. 

Then navigate to Date and time and press the  key. Select between NTP mode Off, 
Auto and Manual. 
Off: NTP mode is disabled—you will then have to specify date and time
Auto: The system locates the NTP server itself
Manual: You must specify the path to the NTP server.

2.	Press the  key to exit the menu putting changes into effect or the  
 Arrow key to leave the menu going one step back. 

Further details are shown on the next page.
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SETTINGS
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German

Italian

Japanese

Korean

Norwegian

Portuguese

Russian
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Scroll with the  and  Arrow 
keys to access languages not 
shown.
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SETTINGS

DATE AND TIME

NTP mode: Auto

NTP server: 2.ntp.somewhere.cu.no

Time zone: GMT–12:00 (International 

Date format: Day, Month, Year

Time format: 24 hours

Off

Auto

Manual
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Activated NTP serverDeactivated NTP server

Setting date and time yourself

You may specify date and time zone settings along with date and time format and the 
date and time of day itself. 
Do as follows:
1.	Start from the Home menu and navigate down to Settings and press the  key. 

Then navigate to Date and time and press the  key.
2.	Use Arrow keys and the  key to set everything as required. 

Setting date and time automatically

You may have the date and time of day set automatically. If you set NTP server to 
Auto, the system will take care of the connection to the NTP server itself. 
If you set it to Manual, you must specify the path to the NTP server. 
At any rate, you must still specify time and date formats as well as the time zone. 

The options shown here are 
available when NTP server Off has 
been chosen only.

CALL SETTINGS

NTP server: Off

NTP server: 2.ntp.somewhere.cu.no

Day: 10 

Month: September

Year: 2010

Time: 13:37

Date format: Day, Month, Year

Time format: 24 hours

Year.Month.Day (yyyy.mm.dd)

Month.Day.Year (mm.dd.yyyy)

Day.Month.Year (dd.mm.yyyy)

Year.Month.Day (yyyy.mm.dd)

Month.Day.Year (mm.dd.yyyy)

Day.Month.Year (dd.mm.yyyy)

10

February

2010

13:37

24 hours

12 hours (am/pm)

24 hours

12 hours (am/pm)

TIME ZONES

GMT-12:00

GMT-11:00

GMT-10:00

GMT-09:00

GMT-08:00

GMT-07:00

GMT-07:00

GMT-07:00

GMT-06:00

GMT-06:00

GMT-06:00

International Date Line West

Midway Island, Samoa

Hawaii

Alaska

Pacific time

Arizona

Mountain Time

Chihuahua, La Paz, Mazattan

Central America

Saskatchewan

Guadalajara, Mexico City, Monterrey

Scroll with the  
and  Arrow keys 
to access settings 

not shown.

DATE AND TIME

NTP server: Auto

NTP server: 2.ntp.somewhere.cu.no

Time zone: GMT–11:00 (Midway Island 

Date format: Day, Month, Year

Time format: 24 hours

DATE AND TIME

NTP server: Manual

NTP server: 2.ntp.somewhere.cu.no

Time zone: GMT–11:00 (Midway Island 

Date format: Day, Month, Year

Time format: 24 hours

Save

Cancel

2.ntp.somewhere.cu.no Setting NTP server to Manual 
lets you specify the path to 
the NTP server. Otherwise 
nothing is different from the 
Auto setting.
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Ring tone volume settingsRing tone selection

Selecting ring tone

The system lets you choose between a multitude of ring tones. 
Do as follows:
1.	Start from the Home menu and navigate down to Settings and press the  key. 
2.	Then navigate to Sounds and alerts and press the  key. Navigate to Ring tone and 

press the  key. Use the  and  Arrow keys to move among the ring tones. Each 
ring tone will be played when you position the cursor at it.

3.	Press the  key to exit the menu putting changes into effect or the  
 Arrow key to leave the menu going one step back.

Setting ring tone volume

The system lets you set the ring tone volume. 
Do as follows:
1.	Start from the Home menu and navigate down to Settings and press the  key. 
2.	Then navigate to Sounds and alerts and press the  key. Navigate to Ring tone 

volume and press the  key. Use the  and  Arrow keys to set the volume.
3.	Press the  key to exit the menu putting changes into effect or the  

 Arrow key to leave the menu going one step back.
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Wallpaper setting optionsKeytone setting

Setting key tone to on or off

The system may be set to emit a sound when you press a key on the remote control 
inside the dialing dialog menu. 
Do as follows:
1.	Start from the Home menu and navigate down to Settings and press the  key. 
2.	Then navigate to Sounds and alerts and press the  key. Navigate to Key tone and 

press the  key. Use the  and  Arrow keys to select. 
3.	Press the  key to exit the menu putting changes into effect or the  Arrow key to 

leave the menu going one step back.

Setting wallpaper on your screen

The system lets you set a wall paper on your screen. This is shown in idle condition 
only.
Do as follows:
1.	Start from the Home menu and navigate down to Settings and press the  key. 
2.	Then navigate to Wallpaper and press the  key. Use the  and  Arrow keys to 

select wall paper. Uploading and inserting a custom wallpaper is explained overleaf.
3.	Press the  key to exit the menu putting changes into effect or the  Arrow key to 

leave the menu going one step back.
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Inserting your own wallpaper

The system lets you upload and use your own wallpaper (for example your logo) on 
your screen. This custom wallpaper picture can be any size up to 1920×1200 pixels.
The custom wallpaper is uploaded by means of the system’s web interface. See the 
Appendices section of the Administrator Guide for your system for further details 
about the web interface.
Do as follows:
1.	Open a web browser and enter the IP address of the codec/endpoint of your 

system. 
2.	Select Wallpaper from the menu bar on the left side of the screen. 
3.	Browse for the file and click the Upload button.
4.	Close the web browser.
5.	Select Custom wallpaper (see the previous page) to put the change into effect.

Note that access to the system’s web interface may have been password protected 
by your administrator.

System information

System information can be listed. 
Do as follows:
1.	Start from the Home menu and navigate down to Settings and press the  key. 
2.	Then navigate to System information and press the  key again. 
3.	To exit this screen, press the Home key (   ).

 

	A shortcut to this function is available. Make sure the system displays the Home 
menu (press the  key on the remote control to display this menu). Then press the 
rightmost softbutton to display the System information.
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RestartingAdvanced configuration entering

Entering the Advanced configuration

Your video system has a separate set of Advanced configuration settings intended 
to be used by system administrators only. These settings may be protected by a 
password.
Aspects of the Administrator settings are discussed in more detail in the section 
“Advanced settings” on page 44.
A full presentation of the Administrator settings can be found in the Administrator 
Guide for your system, available separately for download from Cisco.com.

Restarting the system

Some changes in the system settings, network settings and the infrastructure 
configurations may call for a system restart. 
Do as follows:
1.	Start from the Home menu and navigate down to Settings and press the  key. 
2.	Then navigate to Restart and press the  key.
3.	Use Arrow keys and the  key to make your selection.
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Chapter 2

Making calls
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Placing calls by specifying the name, number or address

Press the  Arrow key a sufficient 
number of times to exit the keyboard 
and enter the list of matches (if such 
a list appears). Then use the Arrow 
keys to navigate to the one to call and 
press the  key.

Press  or the  key to 
actually place the call. 

Press the  key to display 
the Main menu. 

Press as outlined to invoke 
the virtual keyboard.

Use the  Arrow key, as shown, to 
move the cursor up into the virtual 
keyboard (indicated by an orange 
square).

Use the Arrow keys to move about the 
keyboard and the  key to select a character. 
Access special characters and numerics by 
means of the corresponding keys. 
Matches will appear as you write.
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Placing calls using the phone book

Press the  key to display the Phone book. 
This will also invoke the virtual keyboard. 
Your phone book may contain folders, as 
outlined. 
Any search you make will include current 
folder and any subfolders, so if you stay at 
the top level (sometimes referred to as the 
root level), your search will be made within 
all (sub)folders.

Use the  Arrow key, as shown, to 
move the cursor up into the virtual 
keyboard (indicated by an orange 
square).

Use the Arrow keys to move about 
the keyboard and the  key to 
select a character. 
Access special characters 
and numerics by means of the 
corresponding keys. 
Matches will appear as you write, 
as outlined.

Exit the virtual keyboard as explained on the 
previous page.
Navigate to the entry to be called and press 
the  key or the  Arrow key to produce the 
options available. 

Search

My contacts

0.1 - Beijing Office

0.2 - London Office

0.3 - New York Office

0.4 - Oslo Office

0.5 - San Jose Office

0.5 - Washington Office

PHONE BOOK

Search

Abraham Anderson

Adrian Jones

Harry P. Otter

Hedda Gabler

Norah Dollhouse

Peer A. Gynt

Roberta Nielsen

PHONE BOOK

a

Search

Abraham Anderson

Adrian Jones

Harry P. Otter

Hedda Gabler

Norah Dollhouse

Peer A. Gynt

Roberta Nielsen

PHONE BOOK

a

Search

My contacts

0.1 - Beijing Office

0.2 - London Office

0.3 - New York Office

0.4 - Oslo Office

0.5 - San Jose Office

0.5 - Washington Office

PHONE BOOK

Harry P. Otter 
harry.p.otter@somecompany.com

Call

Edit before call

Save to my contacts

Add to participants list

View dialing method

Call the entry selected (press  or the  key).

Edit the entry (for example insert a prefix)  
and then call.

Save the entry to your  
personal list of contacts.

Add to list of participants in a multisite call  
(optional feature).

View dialing method options  
(H.323 and SIP wherever applicable).

More about the phone book can be found in the section “Phone book usage”—click on the topic on the menu line at the top of this page.
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Placing calls by means of the Recent calls list

Press the  key to display 
the Main menu. 

Navigate down to Recent calls 
and then press the  key.

Use the Arrow keys to navigate in 
the list.

Call

Phone book

Recent calls

Add another participant

CALL

Harry P. Otter 
harry.p.otter@somecompany.com

Call

Edit before call

Save to my contacts

Add to participants list

View dialing method

Call the entry selected (press  or the  key).

Edit the entry (for example insert a prefix)  
and then call.

Save the entry to your  
personal list of contacts.

Add to list of participants in a multisite call  
(optional feature).

View dialing method options  
(H.323 and SIP wherever applicable).
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If your video network makes use of the Cisco Telepresence Management System 
(TMS), your video system may be set up for scheduled meetings from remote.
Typically, the TMS works with tools like Microsoft Outlook, permitting employees to 
book and schedule video calls and conferences.
Any bookings applicable to your system will appear on the screen as shown in the 
below example.

When someone is calling you Management systems booking list

Terminating an ongoing call

Press the  key 
on the remote 
control to answer 
an incoming call.

Press the  
 key on the 

remote control to 
reject an incoming 

call.

Press the  key on the remote 
control to terminate an ongoing 

call.

Sept

20

TODAY’S BOOKINGS

NOW - 14:30 
Align weekly

14:30 - 15:00 
Sales meeting planning

15:00 - 15:30 
Release planning

john.doe@videocompany.co.nla
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Terminating a video conference

Calling participants one by one

Setting up a list of whom to call before calling them

Calling more than one (optional)

Provided that your video endpoint is equipped with the optional built-in Multisite 
feature, any point-to-point video call (a call involving two parties only) may be 
expanded to include additional participants. The call will then become a video 
conference. 
Any ongoing video call can then be expanded to a video conference by adding more 
participants at all times (see the right example).
Alternatively, you may set up a list of whom to call before you actually call them and 
then call them all in one go (see the below example).
Note that your video network may have an infrastructure permitting video conferencing—
even if your video system itself does not. This will require the presence of an external 
Multipoint Control Unit (MCU).
The most advanced video systems (those using Codec C60 or C90) can—when 
equipped with Multisite—set up video meetings with four participants (yourself 
included). External MCUs may let you set up conferences with many more 
participants. 
Systems equipped with Codec C20 have no Multisite feature (see   page 30 to 
find out which type of codec your system has). However, all products described in this 
user guide come with Multiway™ installed (see the next page for more on this).
Contact your system administrator for details on how to use external MCUs.

This example shows two entries made before any 
calls are placed. 
To do this start by entering the first person to call 
(directly, via the recent calls list or from the phone 
book), then select Add another participant and add 
a second person. When all have been entered, 
press Call on the remote control or select the Call 
icon in the menu.
For units equipped with MultiSite capabilities, up to 
three participants can be called simultaneously, if 
no external MCUs are used.
After you have entered the participants, press 
the  key to place the calls. Any of these may, 
of course, be fetched from the phone book in the 
usual manner. 

During a call, open the Call menu again…

Then call someone in the usual manner—
by keying in the name, number or address 
(in this case “542”) or by means of the 
phone book. Invoke the virtual keyboard 
(see  “Entering text in text fields” on 
page 7), if convenient.

Finally, navigate down to  Call and 
place the call… 
If you want to add another participant, 
repeat the process. The maximum 
number of participants possible 
depends on your system’s configuration. 

This is the 
participant 

you already 
are in a call 

with.

The next 
participant 

you are 
going to 

call.

Use this 
to place 
the call.

The host of a video conference is the 
one who initiated the conference. This 
is the endpoint to which all the others 
are connected.
The host has the right to terminate the 
connection to any of the participants. 
The participants cannot control any 
of the others, but may disconnect 
themselves from the meeting at all 
times. 
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Do you really want to disconnect this call?

Disconnect all

Disconnect alice.wonderland@mycompany.com

Disconnect 542

Cancel

Call

Meetings

Presentation

Camera control

Settings

HOME

Call

Phone book

Recent calls

Add another participant

CALL

alice.wonderland@mycompany.com

Enter contact... 123

Call

Meetings

Presentation

Camera control

Settings

HOME

Call

Phone book

Recent calls

Add another participant

CALL

alice.wonderland@mycompany.com

542 123

Call

Meetings

Presentation

Camera control

Settings

HOME

Call

Phone book

Recent calls

Add another participant

CALL

alice.wonderland@mycompany.com

542
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Assume that you already are in a call and that you would like to expand the call to include 
someone else. 
Do as follows:

	 Start calling someone else by pressing the   or the  key on the remote control.

Call

Meetings

Presentation

Camera control

Settings

HOME

CALL

alice.wonderland@everywhere.co.nl 
norah.dollhouse@somecompany.com 

Dorian Grey 
Hedda Gabler

Floria Tosca

abc
Recent calls

My contacts

Phone book

	 Enter the number or URI of the person to be included, either directly or by means of the 
phone book or the list displayed) and place the call by pressing the  key. This will put 
the current call on Hold. When the new participant replies, select Join Calls. 

 Resume  Join calls  Hold

Call on hold
Your call with  
james.dowe@somecompany.com 
is on hold.

	 All three of you will now be in the same meeting.

	 Repeat to include more participants if needed.

Using Multiway, Case 1

Someone calls you while you are in a call. You will need to decide whether the calling party 
shall be invited to join the current call or not.

	 Someone calls you while you are in a call. A dialog box giving you three options will be 
shown.

Incoming call
norah.dollhouse@somecompany.com

550092

Accept (put current call on hold)

Accept (disconnect current call)

Reject

	 Select Accept (put current call on hold).

	 When you are ready to create the conference, select Join Calls. 

 Resume  Join calls  Hold

Call on hold
Your call with  
james.dowe@somecompany.com 
is on hold.

	 All three of you will now be in the same meeting.

Case 2 options: If you do not want to set up a Multiway conference, you have the following 
choices in 2. above:
•	 If you want to accept the incoming call instead of the current call, select Accept 

(disconnect current call). 
•	 If you do not want to respond to the incoming call, select Reject. 

Using Multiway, Case 2Using Multiway™ to call more than one

All systems described in this User guide offer Multiway as a means to call more 
than one. Note that successful use of Multiway requires the presence of certain 
infrastructure products. If in doubt check with your system administrator.

The maximum number of participants in a Multiway call is limited by the capabilities of the 
infrastructure of your network only. The two cases described on this page may be combined 
as much as you want. 
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Profile series codecs:

Which codec does my system have?

The optional ability to call more than one participant—the MultiSite feature— does 
not apply to all video endpoints. This depends on the type of codec your system is 
equipped with. The following applies:
•	 Endpoints using Codec C40, C60 and C90 support MultiSite and MultiWay.
•	 Endpoints using Codec C20 do not support MultiSite, but MultiWay.
•	 Quick Set C20 / C20 Plus both use the Codec C20. Consequently, they do not 

support MultiSite, but MultiWay. 

At any rate, MultiSite is an optional feature that may—or may not—be present in your 
endpoint.
If you need to see which type of codec your system is equipped with, open the 
bottom module lid of the system.

Looking for codec type:

Codec C90

Codec C60

Codec C40

Codec C20

Open the bottom module lid as 
shown, to see which type of 
codec you have.
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Chapter 3

Phone book usage



www.cisco.com32

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20 User guide

D14852.02 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, November 2011.  
All contents are copyright © 2010–2011 Cisco Systems, Inc. All rights reserved.

Basic phone book features

Your video system contains a phone book. The phone book is organized in a way very 
similar to what you find in a mobile phone.
It contains a section where you can add your own list of contacts, and most corporate 
solutions will also include a corporate phone list.
This corporate phone list is normally installed and maintained from remote by your 
system administrator through a management system like the Cisco Telepresence 
Management Suite (TMS), which is available separately. 
You cannot edit the corporate list yourself, but you may add entries to My Contacts. 
These may be edited as much as you want. 

Opening the phone book

Navigating in the phone book

Calling an entry in the phone book

... the Phone book menu will now open…

The phone book typically contains your own My contacts and a corporate phone book.
You may create your own list of contacts in My contacts.

Press the  key…

Folders contain 
phone book 
entries (and they 
may even contain 
subfolders).

Search

My contacts

0.1 - Beijing Office

0.2 - London Office

0.3 - New York Office

0.4 - Oslo Office

0.5 - San Jose Office

0.5 - Washington Office

PHONE BOOK

Call

Phone book

Recent calls

Add another participant

CALL

The phone book can 
also be accessed 

from the Call menu.

Navigate in the phone book with the 
Arrow and  keys.
The phone book may contain folders 
indicated by folder icons ( ). Press 
the  Arrow key to display the 
contents of a folder. Repeat, if needed, 
if there are more folder levels.
Whenever you are at a lower level, use 
the  Arrow key to move one level 
back.
Searching for an entry is explained on 
the next page.

Search

My contacts

0.1 - Beijing Office

0.2 - London Office

0.3 - New York Office

0.4 - Oslo Office

0.5 - San Jose Office

0.5 - Washington Office

PHONE BOOK

Search

Abraham Anderson

Adrian Jones

Harry P. Otter

Hedda Gabler

Norah Dollhouse

Peer A. Gynt

Roberta Nielsen

PHONE BOOK

aWhen an entry is located, just press 
the  key to place the call.



www.cisco.com33

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20 User guide

D14852.02 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, November 2011.  
All contents are copyright © 2010–2011 Cisco Systems, Inc. All rights reserved.

Searching in the phone book

The My contacts may contain up to 200 entries, but the entire phone book can be 
virtually unlimited in size. Consequently, using the arrow keys as the only navigation 
device can easily mean a lot of work. What to do?
Enter the search function. By means of a virtual keyboard the search procedure is a 
simple and convenient way of locating an entry.
Your phone book may contain folders, as outlined. Searches made will include current 
folder and any subfolders, so if you stay at the top level (sometimes referred to as the 
root level), your search will be made within all the (sub)folders.

How to search for an entry

Press the  key to display 
the Phone book. This will also 
invoke the virtual keyboard. 

Use the  Arrow key as 
shown to move the cursor 
up into the virtual keyboard 
(indicated by an orange 
square).

Use the Arrow keys to move 
about the keyboard and the  
key to select a character. 
Access special characters 
and numerics by means of the 
corresponding keys. 
Matches will appear as you 
write, as outlined.
How to call the selected 
entry is shown in the section 
“Making calls”.

Search

My contacts

0.1 - Beijing Office

0.2 - London Office

0.3 - New York Office

0.4 - Oslo Office

0.5 - San Jose Office

0.5 - Washington Office

PHONE BOOK

Search

Abraham Anderson

Adrian Jones

Harry P. Otter

Hedda Gabler

Norah Dollhouse

Peer A. Gynt

Roberta Nielsen

PHONE BOOK

a

Search

My contacts

0.1 - Beijing Office

0.2 - London Office

0.3 - New York Office

0.4 - Oslo Office

0.5 - San Jose Office

0.5 - Washington Office

PHONE BOOK

Add more letters to narrow and refine your search.
Example: Keying in da, will return entries like Dave Olson and David Jones, but also John 
Dahl and Vittorio Dalmazzino. There is no case sensitivity.
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Adding an entry from recent calls or the phone book

Adding an entry manually to My contacts

Open the phone book by pressing the  key on the remote control and  
navigate to My contacts:

Search

My contacts

0.1 - Beijing Office

0.2 - London Office

0.3 - New York Office

0.4 - Oslo Office

0.5 - San Jose Office

0.5 - Washington Office

PHONE BOOK

Press the  key to show the contents of My contacts: 

Search My contacts

     Add new contact

10.47.148.797

Adrian Jones

Alice Wonderland

Hedda Gabler

Norah Dollhouse

MY CONTACTS

abc

Navigate to Add new contact and press the  key:

NEW CONTACT

Name

Number / URI

Save

Cancel

AbcShown  
ghosted  
because  
nothing  
has been  
entered yet.

Enter name and number or address (URI) of the new contact. After you have entered 
this information, the Save field will no longer appear ghosted and you may navigate  
down to this field and press the  key to save your new entry.

Alternatively, navigate down to Cancel and press the  key to exit the dialog box 
without saving the new entry.

Adding new contacts to the phone book

New contacts can be added to My contacts only. Other entries must be entered by 
your system administrator.

While you are inside the phone book or inside the list of recent calls, navigate to the entry 
you would like to copy to My contacts and press the  key or the  Arrow key to show the 
Options menu:

Navigate down to Save to my contacts and press the  key to open the dialog box that allows 
you to edit the entry, if needed. 
This is similar to entering a new contact manually (see right for details), but in this case the 
name and number or address (URI) of the copied contact has already been filled in for you 
by the system. If you want to edit the information entered, you may do so. Remember to save 
before leaving the menu.

SAVE TO MY CONTACTS

Name

Number / URI

Save

Cancel

abc
Harry P. Otter

H323:harry.p.otter

Harry P. Otter 
harry.p.otter@somecompany.com

Call

Edit before call

Save to my contacts

Add to participants list

View dialing method

harry.p.otter@somecompany.com 
Received 20.06.11 16.29

hedda.gabler@somecompany.org 
Placed 20.06.11 15.10

dorian.grey@myself.net 
Missed 20.06.11 14.55

frodo,b.aggins@myshire.org 
Received 20.06.11 12.20

floria.tosca@somecompany.org 
Placed 20.06.11 08.17

RECENT CALLS
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Editing entries in the phone book

Editing existing entries in the phone book

You may edit and delete entries in My contacts any time. Since updates in the 
corporate phone book(s) made by your system administrator will fail to affect My 
contacts, you may have to use this feature from time to time if corporate phone book 
changes are made.

You may call the entry directly.

You may edit the number or URI.

You may add the entry to participants list when setting up a 
conference.
If the entry is listed with more dialing methods than the default, you 
may use this to, for example use H.323 instead default SIP (or the 
other way around).

You may remove the entry from the list.

You may edit contact details.

EDIT CONTACTS

Name

Number / URI

Save

Cancel

abcHedda Gabler

hedda.gabler@some

Search

My contacts

0.1 - Beijing Office

0.2 - London Office

0.3 - New York Office

0.4 - Oslo Office

0.5 - San Jose Office

0.5 - Washington Office

PHONE BOOK

Open the phone book by pressing the  key 
and then navigate to My contacts. Press the  
key to open My contacts.

Search My contacts

     Add new contact

10.47.148.797

Adrian Jones

Alice Wonderland

Hedda Gabler

Norah Dollhouse

MY CONTACTS

abc

Navigate to the entry to be edited 
and press the  key.

hedda.gabler@somecompany.com 
hedda.gabler@somecompany.com

Call

Edit before call

Add to participant list

View dialing methods

Remove from list

Edit contact details
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Chapter 4

In-call features
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Sharing contents

General recommendations tips for making your video meeting room as good as 
possible are described in the Administrator guide for this product. The Administrator 
guide may be downloaded from www.cisco.com/go/telepresence/docs.

Dual video stream
With dual video stream you can view two different live video streams simultaneously—
the main video and one additional source. This could for example be both a PC 
presentation and the person who gives the presentation.
If a video system does not support dual video stream, no second video stream will be 
established for this system and the PC presentation will be shown as the main video.

	 Make sure the PC does not cover your line of sight to any of the microphones.  
This will reduce the perceived audio quality at the far end.

	 Locate the DVI cable and connect the PC to the video system. 
Connect the audio mini-jack output from the PC, or any other 
source—including Ipod—to the mini-jack socket of the cable to 
get sound. Connect the RCA connectors to the corresponding 
sockets on the codec/endpoint.

	 The default presentation source will be activated when you press 
the Presentation button (   ) on the remote control, as outlined. 

The DVI / VGA input is compliant with VESA Extended Display 
Identification Data (EDID) and will be able to notify the PC of the 
supported output formats.

Sharing PC contents

•	Normally you must press a special key combination to switch the PC image from the PC 
screen to the video screen.

•	Check that the presentation source is correctly defined. Access to this setting may be 
password protected by your system administrator. The procedure is described in the 
Administrator guide for this product.

•	Make sure your PC is set to activate your VGA output.

To specify which source to serve as presentation source select it as shown here. Note that 
the name of each source can be changed, consult your administrator for details on this. All 
options shown are not available to all systems.

If the shared contents fail to show

Selecting the source

Call

Meetings

Presentation

Camera control

Settings

HOME

Call

Meetings

Presentation

Camera control

Settings

HOME

Secondary camera (no signal)

PC

DVD

Document camera

No presentation

PRESENTATION
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	 In a call use the Arrow keys of the remote control to enter the camera 
control mode. Softbuttons will now appear as shown below.

	 Press the leftmost Function key to access the far end camera.

	 Proceed as for near end camera control.

Controlling far end camera (far side)

Controlling the cameras

During a call, you may control where your own camera is pointing (i.e. pan and tilt)
and the zoom. However, far end systems with remotely controllable cameras may 
also permit you to control their camera’s panning and zooming. This is called Far end 
camera control.

For video conferences with more than two participants, far end is an ambiguous term. 
If you are the initiator of a conference the only far end camera controllable by you will 
be the first participant you called. The other participants may all control your camera, 
but they cannot control each other.

	 In a call use the Arrow keys of the remote control to enter the camera 
control mode. Softbuttons will now appear as shown below.

	 Use the Arrow keys and the Zoom keys to pan, tilt and zoom your 
camera.

	 Exit the mode when finished.

Controlling your own camera (near side)

Access to far 
end camera (if 
far end camera 
is remotely 
controllable).

Access to your 
own camera 
presets, if 
defined.

Access to your 
own camera’s 
settings.

Access to your 
own system’s 
main source 
setting.

Exit this 
mode.

Back to near end 
camera control.

Exit this 
mode.
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Chapter 5

Scheduled meetings
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•	 Select the Join meeting and press OK. This connects you to the “dial in“ address. .
•	 Select Snooze and press OK to temporarily hide the Reminder for 5 minutes..
•	 Select Dismiss and press OK to close the Reminder.

•	 In the Reminder navigate down to Meeting details and expand this menu item to see 
meeting details. An example of Meeting details is shown on the next page.

To join a meeting or not Viewing meeting details

Joining a meeting

Your system may be connected to a management system capable of scheduling 
meetings for your video systems. Any meetings scheduled will then appear in the Table of 
Meetings as outlined below. You cannot navigate in that table with the remote control. To 
produce a list in which you can navigate with the remote control, see   “Displaying a list 
of upcoming meetings” on the next page.
The Table of Meetings contains 14 days of scheduled meetings. The list is sorted 
using Grouping headers. The main grouping category is by day (e.g.: TODAY, 
TOMORROW, then WEDNESDAY, July 20, 2011 etc).
On your video system the Meeting Reminder will appear once it is possible to join a 
meeting. Exactly when that will be depends on the Start time buffer setting, which 
has been set by your system administrator. Default buffer setting is 10 minutes.
The meeting reminder contains a time indicator stating when the meeting starts, or 
alternatively for how long the meeting has been going on (an ongoing meeting is 
referred to as a Meeting in progress). 
The text Starting now will be shown during a time interval spanning from 30 seconds 
before to 30 seconds after the scheduled start time of the meeting. 

Learning more about a meeting

You may use the Reminder to learn more about the announced meeting—just navigate 
down to Meeting details and expand the item.  
Meeting details will typically include who the organizer is; whether the meeting will be 
recorded or not; a description of the meeting; whether it may be extended, if needed 
(see   “Extending a scheduled meeting” on page 43 for more on this); dial in 
information etc.
Observe that when a scheduled meeting appears as Private meeting it will contain 
information about the organizer only. There will be no title, no expandable meeting 
outline nor will there be any dial-in information.
See    the next page for an example of how the Meeting details are presented. 
 

Example of  
Table of 
Meetings

Example of  
Meeting Reminder
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•	 In the Home menu, navigate down Meetings and expand the item to produce a List of 
Meetings.

1.	Navigate to the meeting to be looked into and expand the menu item. 
2.	Then navigate down to Meeting details and expand this menu item to see meeting details.

To display a meetings list you can navigate within Viewing details of any meeting

Displaying a list of upcoming meetings

If you want to take a closer look on any of the upcoming meetings including your video 
system, you will need to look in a List of Meetings that lets you navigate in it with the 
remote control.
Otherwise this list is identical to the table of upcoming meetings, as can be seen below.

Meeting details of any upcoming meeting

Once you have selected one of the upcoming meetings in the list, you may look into 
the details of that meeting.
Even from this menu you may join the meeting, provided that you are inside the time 
window allowing you to join. The length of this time window depends on the Start 
time buffer defined by your system administrator. See    the previous page for more 
on this.
An upcoming meeting will be shown in the Meeting Reminder, which pops up by itself 
on the screen, see   the previous page for more on this.
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•	 If you already are in a call, the Join meeting button will change to JOIN & END CURRENT.
•	 Select JOIN & END CURRENT button to join the new meeting, ending the current. 
•	 Select Join & Hold Current to temporarily join the meeting.
•	 Select Snooze to temporarily hide the Reminder for 5 minutes. 
•	 Select Dismiss to go on with your current meeting.
•	 You can always look into the meeting details to help you make up your mind, select 

Meeting details for this.

1.	Expand View meetings as outlined. 
2.	Then navigate down to the meeting you want to join and join in the usual way.

Joining the meeting Selecting which meeting to join

Joining when already in a call

If you already are in a call (a video meeting), the Join meeting field will change to reflect 
the new situation.

Parallel meetings (concurrency)

When Parallel meetings occur (two or more meetings taking place simultaneously), an 
alert will appear, as outlined.
Selecting View meetings followed by pressing OK will produce the List of Meetings, 
with the parallel meetings shown at the top of the list as outlined below. 
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•	 If an extension is sustainable, the Meeting will end notification will include an Extend and 
a Dismiss option.   

•	 To extend a meeting, make sure the Extend field is selected, as outlined, and then press 
OK.

•	 If you do not want to extend the meeting, navigate to Dismiss and press OK.

Extending the meeting

Extending a scheduled meeting

Scheduled meetings have a fixed start and end time. When you are in a scheduled 
meeting, a Meeting will end notification appears 10 minutes, 5 minutes and 2 minutes 
before the meeting is brought to an end by the management system. 
You may want to extend an ongoing meeting. This will be accepted by the system 
provided that no other meeting is scheduled on the video system during the period of 
extension.
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Chapter 6

Advanced settings
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The Advanced configuration settings are aimed at system administrators only and may 
have been password protected by your system administrator. Unless you are the system 
administrator you should normally leave these settings as they are.
The IP settings (not shown) are also aimed at system administrators.
The Advanced configuration settings and the IP settings are described in the Administrator 
Guide applying to your video system. This guide can be downloaded from www.cisco.com/
go/telepresence/docs.
The password may not have been set. If you decide to give your system a password, take 
care. If you forget your password contact your Cisco representative for help.

Entering the Administrator settings

Administrator settings & passwordAbout the Administrator settings

The Administrator settings lets you define extra softbutton functions; change the IP 
settings of the system; use the advanced configuration options and change the menu 
access password. 
Your video system can be configured through its web interface, but it may also be 
configured through the Advanced configuration. This is all normally done by your 
system administrator, who may have password protected the access to the Advanced 
configuration. 

Call

Meetings

Presentation

Camera control

Settings

HOME

Layout

Main source: Camera

Call settings

Language: English

Date and time

Sounds and alerts

Wallpaper: Growing

System information

Administrator settings

Restart

SETTINGS

Then navigate to Administrator settings 
and press the  key again to display the 
options available.

Starting from the Home menu, 
navigate down to Settings and 
press the  key. 

Enter the password. Invoke the virtual keyboard, if 
needed (see “Placing calls by specifying the name, 
number or address” on page 24 for details on this).
Navigate to OK to enter the Administrator settings menu.

Call

Meetings

Presentation

Camera control

Settings

HOME

Call

Meetings

Presentation

Camera control

Settings

HOME

Layout

Main source: Camera

Call settings

Language: English

Date and time

Sounds and alerts

Wallpaper: Growing

System information

Advanced

Restart

SETTINGS

Please enter your 
Administrator password:

ADMINISTRATOR PASSWORD

***

OK

Cancel
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Assigning a function to a softbutton

Assigning softbutton functions

The Function keys of the system’s remote control are used to control the softbuttons 
appearing along the lower end of the screen—see also   ”Navigating in the menus” 
on page 6 for more. 

The softbuttons are context sensitive, which means that they appear only when 
needed and not else. You may enhance your system’s perceived performance by 
assigning your own functionalities to the softbuttons.

Call

Meetings

Presentation

Camera control

Settings

HOME

Layout

Main source: Camera

Call settings

Language: English

Date and time

Sounds and alerts

Wallpaper: Growing

System information

Advanced

Restart

SETTINGS

ADMINISTRATOR SETTINGS

Programmable softbuttons

Audio input levels

Connect to Callway

IP settings

Advanced configuration

Change password

SYSTEM MODE

In idle

In call

Navigate to Programmable softbuttons, as outlined, and 
press the  key. Se also the previous page, if needed.

Call

Meetings

Presentation

Camera control

Settings

HOME

Layout
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In call
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Softbutton  1: Not set

Softbutton 2: Not set

Softbutton 3: Not set

Softbutton 4: Not set

Softbutton 5: Not set

Main source selection

Camera preset

Speed dials

SOFTBUTTON 1

Select among the options available and press the   key. The 
options are presented in detail on the following pages.

Navigate to select whether the softbutton function shall 
apply to idle or to in-call conditions. Press the  key. 
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SYSTEM MODE

In idle

In call

Softbutton  1: Not set

Softbutton 2: Not set

Softbutton 3: Not set

Softbutton 4: Not set

Softbutton 5: Not set

IN CALL

Navigate to select which softbutton to assign a function 
to. Press the  key. 

If you want a softbutton assignment to apply 
to both idle and in-call situations, you must 
assign a function twice. 
There must be one setting for idle and 
another one for in-call mode.
Note that any softbutton may be assigned to 
any of the functions available. 
Consequently, setting one softbutton to a 
specific function for idle situations does 
not require that the same function must be 
assigned to the same softbutton for in-call 
situations.
However, doing so may appear more logical in 
many cases.

The description presented on this page 
assumes that you are already inside the 
Administrator settings, as described on the 
previous page.
The access to the Administrator settings 
may have been password protected by your 
system administrator. Contact your system 
administrator, if in doubt.

!
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Assigning Main source selection softbutton

Creating softbutton for Main source selection

If you want direct access (via the softbuttons along the bottom line of the screen) to 
the source used, you should assign the function Main source selection to one of the 
softbuttons. Below we use Softbutton 1 as an example, but the function may, of course, 
be assigned to any of the five softbuttons.

The number of sources 
available will depend on 
your system.

How to get to the menus shown below  
left and below right is described on 
the previous page.

!
If you have set Softbutton 1 to PC as main 
source, you may want to set Softbutton 2 to 
Camera (or the other way around) in order to 
be able to conveniently switch between the 
two.

Assigning Camera preset softbutton

Creating softbutton for Camera Preset

If you want direct access (via the softbuttons along the bottom line of the screen) to 
predefined camera presets, you should assign the function Camera preset to one or 
more of the softbuttons. 
Note that camera presets must have been defined before you start assigning presets 
to any of the softbuttons—see   “Camera presets” on page 9 for more on 
camera presets.
Below we use Softbutton 4 as an example, but the function may, of course, be 
assigned to any of the five softbuttons
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Assigning Camera preset softbutton Example of customized softbuttons

How to get to the menu shown below is described two pages back.

!

Softbutton—Speed dials

If you want direct access (via the softbuttons along the bottom line of the screen) to 
contacts in the phone book, you should assign the function Speed dials to one or more 
of the softbuttons. 
Note that assignments can be made to existing contacts only (My contacts as well as 
the corporate phone book). To add a contact to your list of contacts, see  page 34.
Below we use Softbutton 5 as an example, but the function may, of course, be 
assigned to any of the five softbuttons.

Customized softbuttons—how they appear

The below illustration shows how the video system screen may look with five 
customized softbuttons defined.

Sept

20

    Camera   PC    Zoom in    Zoom out    Norah Dollhouse
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Softbutton—Clearing softbuttons

You may clear softbuttons that you no longer want to appear. This is done via the 
Clear softbutton at the bottom of the menu. You do not have to clear a softbutton 
function before assign the same softbutton to another function. That may be done 
right away.
For more on how to get to the below menu—see   “Assigning softbutton functions” 
on page 46 for details.

 

	Make sure you select the right softbutton (idle mode or in-call mode).
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On our web site you will find an overview of the worldwide Cisco 
contacts.

Go to: http://www.cisco.com/web/siteassets/contacts/index.html

Corporate Headquarters
Ciso Systems, Inc.

170 West Tasman Dr.
San Jose, CA 95134 USA

THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS 
IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL 
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The Cisco implementation of TCP header compression is an adaptation of a 
program developed by the University of California, Berkeley (UCB) as part of 
UCB’s public domain version of the UNIX operating system. All rights reserved. 
Copyright © 1981, Regents of the University of California. 

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT 
FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS” WITH 
ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL 
WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, 
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DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN 
IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF 
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Cisco and the Cisco Logo are trademarks of Cisco Systems, Inc. and/or its 
affiliates in the U.S. and other countries. A listing of Cisco’s trademarks can 
be found at www.cisco.com/go/trademarks. Third party trademarks mentioned 
are the property of their respective owners. The use of the word partner does 
not imply a partnership relationship between Cisco and any other company. 
(1005R)

Any Internet Protocol (IP) addresses and phone numbers used in this document 
are not intended to be actual addresses and phone numbers. Any examples, 
command display output, network topology diagrams, and other figures 
included in the document are shown for illustrative purposes only. Any use of 
actual IP addresses or phone numbers in illustrative content is unintentional and 
coincidental.
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